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Chapter 1

 

Document Overview

 

The Sun Java™ Desktop System is an affordable, comprehensive, fully integrated desktop client environment that 
includes administration and developer tools as well as enterprise-ready support to help reduce the complexity of 
desktop management and provide a secure computing environment. The Java Desktop System lowers business 
costs by supporting older hardware, while offering end users an easy-to-use desktop interface.

The components of the desktop are based on open source and open standards, and include the GNOME desktop 
environment, StarOffice™ productivity suite, Mozilla™ browser, Evolution mail and calendar client, and Java 2 Platform, 
Standard Edition (J2SE™ platform). The Java Desktop System offers — at no additional cost — server-side administration 
tools to enable centralized configuration, deployment, and administration of the user desktop environment. In 
addition, the Java Desktop System also includes advanced developer tools to assist developers in creating Java tech-
nology-based applications for the desktop.

This document provides the IT implementor, such as a CIO, system architect, IT manager, or system administrator, 
with an overview of the options available for migration from a Microsoft Windows (“Windows”) operating environ-
ment to the Java Desktop System. In addition to step-by-step migration procedures, this document also describes 
the interoperability between the Java Desktop System and a Microsoft environment.
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Chapter 2

 

Migration Roadmap

 

This section offers a phased approach to migration, and outlines some premigration considerations.

 

Phased Transition Scenarios

 

Table 1. The four transition phases

 

Phase One: On Windows, Migrate Desktop Applications

 

The Windows OS is retained, and basic desktop applications are migrated to cross-platform equivalents. The StarOffice 
suite replaces Microsoft Office, and the Mozilla browser replaces Internet Explorer. In this phase, Microsoft mail, 
file storage, and printing services remain in use and are accessed via the Java Desktop System interoperability protocols 
and interfaces.

 

Table 2. Migrate desktop applications

 

Note – 

 

Outlook, Exchange Server, and Active Directory remain in use.

 

Status Quo Phase One Phase Two Phase Three

 

• Windows
• Microsoft Internet Explorer
• Microsoft Office
• Microsoft Outlook

• Windows
• Mozilla
• StarOffice
• Outlook

• Java Desktop System
• Mozilla
• StarOffice
• Evolution

• Java Desktop System
• Mozilla
• StarOffice
• Evolution

• Microsoft Exchange Server
• Active Directory

• Exchange Server
• Active Directory

• Exchange Server
• Active Directory

• Java Enterprise System

 

Phase Four — Application Migration

 

• Ongoing migration of legacy applications to Java, open 
source, and other UNIX® application equivalents

 

Migrate Primary Tasks

 

StarOffice suite replaces Microsoft 
Office

• Convert document formats.
• Develop an interactive document sharing strategy.

Mozilla browser replaces Internet 
Explorer

• Transfer bookmarks.
• Access MSN Messenger instant messaging via Gaim.
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Further detail on migrating desktop applications is presented in the next chapter.

 

Phase Two: Move to the Java Desktop System

 

The Java Desktop System replaces Windows, and Evolution replaces Outlook as the mail, calendar, and personal infor-
mation management client. In this phase — as in phase one — Microsoft mail, file storage, and printing services 
remain in use and are accessed via the Java Desktop System interoperability protocols and interfaces. Evolution 
will now access and interoperate with Microsoft directory, authentication, messaging, and collaboration services.

 

Table 3. Migrate e-mail, calendar, and other personal information management components

 

Note – 

 

Exchange Server and Active Directory remain in use.

 

Phase Three: Migrate Network Services

 

The Java Enterprise System replaces Exchange Server/Active Directory services. Phase three migration delivers 
simplified maintenance as well as enhanced interoperability between the Java Desktop System and the network.

 

Table 4. Migrate network services

 

Phase Four: Migrate Applications

 

In phase four, which may overlap phases two and three, legacy applications are migrated to the Java Desktop 
System environment.

 

Table 5. Migrate legacy applications

 

Migrate Primary Tasks

 

Evolution replaces Outlook • Import existing e-mail.
• Import existing preferences and contacts.
• Access Microsoft file services via NFS/SAMBA.
• Access Microsoft printing services via SAMBA.
• Access Microsoft directory and authentication services via LDAP or Kerberos 

authentication.
• Access Microsoft mail, messaging, and collaboration services via IMAP4 and/or POP.

 

Migrate Primary Tasks

 

Java Enterprise System replaces 
Exchange Server/Active Directory 
services

• Set up and configure the Java Enterprise System servers and software, including the 
directory server, messaging server, and calendar server.

• Configure storage based on estimated requirements.
• Extract user data, convert to LDAP, and load to directory server.
• Migrate user e-mail and calendar data to the Java Enterprise System environment.
• Configure user clients to access the Java Enterprise System services.

 

Migrate Primary Tasks

 

Java, open source, and other UNIX 
applications replace Microsoft 
applications

Choose one of the following possibilities:
• Use Java, open source, or other UNIX application equivalents.
• Reengineer or port applications to the Java environment.
• Continue to run a few Windows applications — see Chapter 5 for details.
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Chapter 3

 

Migrating Desktop Applications

 

The Java Desktop System includes the following applications for core desktop productivity:
• StarOffice office productivity suite
• Mozilla browser
• Evolution mail and calendar client

This section describes best practices for migration and interoperability of these applications.

 

StarOffice Migration

 

The StarOffice productivity suite is the leading alternative to Microsoft Office around the world, running on Windows 
as well as Linux and the Solaris™ Operating System (OS). The StarOffice suite offers word processing, spreadsheet, pre-
sentation, drawing, and database capabilities. With its familiar interface, StarOffice software enables quick produc-
tivity and results for the business user and elegant output for the consumer. It also enables export to PDF and to 
the Macromedia Flash format. The StarOffice Configuration Manager simplifies enterprise deployment in a Windows 
environment. Also included are the StarOffice Software Development Kit, a macro recorder, and support for assistive 
technologies as well as for complex text layouts.

Sun has developed the StarOffice suite to be file compatible with Microsoft Office and easy to learn for 
Microsoft Office users.

 

Table 6. StarOffice productivity suite components

 

Component Purpose

 

StarOffice Writer • Word processing

StarOffice Calc • Spreadsheet

StarOffice Impress • Presentation

StarOffice Draw • Graphics

StarOffice Base • Database
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Basic Migration

 

In most cases, migrating files from Microsoft Office to the StarOffice suite is as simple as opening Office files in 
StarOffice software and saving them in the StarOffice XML file format. This conversion can also be run as a batch 
process using the Document Converter AutoPilot. The original Microsoft Office files should be archived, and an 
Office license retained for the occasional retrieval from archive.

To learn more about StarOffice migration, including migration of databases and complex documents, please 
see the 

 

Migrating to StarOffice Software from Microsoft Office 

 

located at sun.com/staroffice/whitepapers.

 

Document Exchange in a Mixed Environment

 

Many enterprises operate a mixed environment, where some users choose to remain with Microsoft Office while 
others migrate to the StarOffice suite. In such situations, a standard for document exchange needs to be identified. 
The long-term goal should be standardization on the StarOffice XML file format, which is open and published, and 
eliminates any dependency on a single vendor or product version. Furthermore, use of the StarOffice format provides 
developers with the freedom to write their own tools and applications to work on documents and templates. For the 
exchange of documents that are only to be viewed and not edited, StarOffice software provides the perfect solution 
through its one-click PDF output capability.

If Microsoft Office is the organization's standard office document format, then the StarOffice suite can be set 
up to save documents in this format by default. While standardizing on the Microsoft format may superficially 
seem like a simple approach, it would undermine a major benefit of migration, namely openness, and would 
reinforce dependency on a closed, proprietary file format, possibly resulting in high costs into the indefinite future.

 

Mozilla Browser Migration

 

The Mozilla browser provides advanced Web browsing capabilities, full-featured e-mail functionality, and support 
for a variety of plug-ins, including Adobe® Acrobat, Macromedia Flash Player, and RealNetworks RealPlayer. Mozilla 
browser e-mail components can integrate with an existing Microsoft environment using the IMAP4 and POP protocols. 
This cross-platform, open source browser is included in the Java Desktop System and is based on Gecko, a fully 
standards-compliant layout engine that strictly adheres to World Wide Web Consortium (W3C) standards.

 

Table 7. Mozilla 1.4 browser components

 

Component Purpose

 

Browser • Standards-compliant browser for viewing Web pages

HTML Composer • Create Web pages

E-Mail Client • Send and receive e-mail

Address Book • Manage personal contact information

ChatZilla • IRC chat client
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Mozilla Migration Steps

 

1. Migrate Outlook mail folders

– Launch the Mozilla browser (on your Windows system); from the “Tools” menu, choose “Import.”
– Select “Mail” and then “Outlook.”
– Mozilla will proceed to import existing Outlook mail.
– Once importing is completed, find the imported mail folder under “Local Folders” and copy it to the Java 

Desktop System client hardware.

 

Note – 

 

To migrate profile and preference data from Netscape™ Communicator software, the Netscape Navigator™ 
browser, or an earlier version of the Mozilla browser, click “Profile Migration.” To migrate local mail folders from 
the Netscape Navigator browser, either 1) copy Netscape 4.x local mail folders to a new directory or 2) allow the 

 

Mozilla browser to share the same local mail folders with the Netscape Navigator browser.

2. Integrate with IMAP4 and POP servers

– The Mozilla browser mail client can integrate with IMAP4 and POP servers. See 

 

Chapter 4, Interoperability 
With Enterprise Network Services

 

 for details on accessing these protocols in a Microsoft environment.

3. Integrate Windows plug-ins

– The Java Desktop System includes native versions of Adobe Acrobat Reader, Macromedia Flash Player, 
and RealNetworks RealPlayer. For additional Windows plug-ins, the CrossOver plug-in from CodeWeavers 
(codeweavers.com) enables the use of many Windows plug-ins directly from the Mozilla browser. It supports 
QuickTime, Shockwave Director, Windows Media Player 6.4, Word Viewer, Excel Viewer, PowerPoint Viewer, 
and others.

 

Evolution Mail and Calendar Client Migration

 

The Evolution mail and calendar client is very similar in look and feel to Outlook. Evolution provides e-mail, calen-
daring, meeting scheduling, contact management, and task lists in a single, easy-to-use application. Evolution can 
interoperate with existing Exchange Server services using POP and IMAP4 or by using a connector to Exchange Server.

Table 8 describes the file formats and associated e-mail folders, address book data, and preferences that can be 
imported to Evolution.

 

Table 8. Evolution file format integration

 

Format Applications That Use the Format

 

VCard (.vcf, gcrd) • The GNOME address book format, also used by many other contact management 
applications

iCalendar (.ics) • The iCalendar format, used by Palm OS-based handhelds, Evolution, and Outlook

LDAP Data Interchange Format 
(LDIF)

• A standard data format for address book cards

MBox (mbox) • The e-mail box format used by Mozilla, Evolution, and many other e-mail clients
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Evolution Migration Steps

 

1. Import existing e-mail from the formats listed in Table 8

– In Evolution, click “File->Import.” The Welcome Screen will appear.
– Click “Next” and then select “Import a Single File.”
– Select the file to import and click “Import.”

 

Note – 

 

Before importing mail from Netscape software, be sure to select “File->Compact All Folders”. If this step is 

 

skipped, Evolution will import and make new all the deleted messages in the Trash folders.

2. Import preferences, contacts, and other data from the formats listed in Table 8

– In Evolution, click “File->Import.”
– The Welcome Screen will appear. Click “Next” and then select “Import Data and Settings from Older Programs.”
– In the left column, select the applications from which to import information. Next, select check boxes to 

import different properties of each application. Once done, click “Next” and then “Import.”

Existing e-mail from the proprietary Outlook and Outlook Express (.mbox) format can also be imported

– While in the Windows environment, import files into the Mozilla browser, which uses the standard.mbox 
format. Netscape, Eudora, or any other browser that uses the .mbox format can also be used.

– Copy the imported files to the system or partition used for Evolution.
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Chapter 4

 

Interoperability With Enterprise Network Services

 

Enterprise network services provide the infrastructure needed to develop, deploy, and operate enterprise applications. 
Sun delivers enterprise network services through the Java Enterprise System, which interoperates seamlessly with 
the Java Desktop System.

Compared to competing offerings, the Java Enterprise System reduces the complexity of acquiring, deploying, 
and operating server software, and provides better control over software planning and licensing — all at an affordable 
cost. The Java Enterprise System is modular and based on open standards, so organizations can selectively acquire 
and deploy the network services they need. The Java Desktop System can also interoperate with an existing Windows 
infrastructure, enabling users to access data, files, and printers associated with Windows.

This section first describes the differences between the services offered by the Java Enterprise System and those 
offered in a Windows environment. How to interoperate with existing Windows services is then explained in detail.

 

Java Enterprise System Services

 

The Java Enterprise System interoperates seamlessly with the Java Desktop System, and provides:
• Network Identity services
• Application and Web services
• Communication and Collaboration services
• Portal services
• Availability services
• Security services

The Java Enterprise System is licensed with end-to-end support, maintenance, education, and consulting to 
reduce cost and complexity of acquisition, deployment, and operation.



 

Sun Microsystems, Inc.

 

Interoperability With Enterprise Network Services

 

  P9

 

A Common Set of Features and Standards

 

The Java Enterprise System delivers a set of shared technology components and component products for enhanced 
integration and simplified maintenance. The Java Enterprise System will grow over time; the following examples 
represent just a few of the features and standards currently included:
• Unified Network Identity infrastructure, providing data consistency, secure user identity, and easy addition of 

new identity-enabled applications
• Single sign-on for all services, providing a superior user experience and dramatically reducing help desk costs
• Common installation, simplifying and improving deployment times and maintenance
• Consistent support for high-availability deployment of system components
• Interoperability features for easy operation in established environments, including Network Identity and Portal 

support for Sun, IBM, and BEA application servers; plug-and-play support for standards-based portlets; and 
support for Outlook and Evolution messaging and calendar clients for maximum efficiency without the cost

Table 9 matches Java Enterprise System components with equivalent Microsoft components.

 

Table 9. Java Enterprise System components and Microsoft equivalents

 

For a more detailed look at Java Enterprise System features and benefits, please visit sun.com/software/
javaenterprisesystem.

 

Microsoft Services and the Java Desktop System

 

The Java Desktop System lets IT managers utilize existing Microsoft back-end protocols. Table 10 shows the interop-
erability options available for accessing Microsoft network services in the Java Desktop System environment.

 

Table 10. Java Desktop System interoperability options with Microsoft network services

 

Java Enterprise System Component Microsoft Equivalent

 

Java System Calendar Server Exchange Server

Java System Messaging Server Exchange Server

Java System Directory Server Active Directory

Java System Web Server Internet information Server

 

Type of Service Microsoft Interoperability Options

 

Directory and Authentication Services 
(Exchange Server and Active Directory)

• LDAP user authentication services
• Kerberos authentication using Active Directory

Mail and Messaging Services • POP
• IMAP4
• Gaim XMPP Gateway (instant messaging using MSN Messenger)

Collaboration Services • Java Enterprise System Calendar Server Gateway

File Storage Services • NFS
• SAMBA

Printing Services • SAMBA
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Accessing Microsoft Directory and Authentication Services

 

User authentication services manage the access or the withholding of access to system resources, applications, 
other services, and physical devices. The Java Desktop System can interoperate with Microsoft directory and 
authentication services in two ways:
• LDAP user authentication services
• Kerberos authentication using Microsoft Active Directory

 

LDAP

 

The Java Desktop System can be configured to work with the open-standard Lightweight Directory Access Protocol 
(LDAP), which is widely used on UNIX and Linux systems, by following these steps:

 

Note – 

 

WARNING: Misconfiguring LDAP authentication can possibly lead to the machine being locked out until an 
administrator can attend to the machine in single-user mode. The following steps assume that you are familiar 
with your LDAP authentication server configuration and have configured the proper user names and passwords in 

 

the server.

1. Enable LDAP on Exchange Server

– Modify the default protocol mode in Exchange Server to accept LDAP.

2. Java Desktop System client: Enable LDAP authentication

– Run the Java Desktop System Configurator by selecting “Launch/Run Application” and enter the command 
“yast2,” and click “run.”
– If not running as root, enter the root password.
– Go to “Network/Advanced” and then click “LDAP client.”
– If you do not have the “pam_ldap” and “nss_ldap” modules installed, the configurator will prompt you to 

do so now. If you wish to replicate LDAP authentication on many clients, you can speed this process by 
installing those two modules ahead of time.

– When the “LDAP Client Configuration” screen comes up, click “Use LDAP.”
– Enter the base name of your LDAP authentication server domain tree in “LDAP base DN.” For example, to 

authenticate against Sun's LDAP service you would enter “dc=sun,dc=com.”
– Enter the host name or IP address of the authentication server in “Addresses of LDAP servers” (you can 

enter more than one).
– Select the TLS/SSL and/or Version 2 boxes if they apply.
– Confirm the choices by clicking the “Finish” button.

This will save the host name and the base DN into the file named ldap.conf located in /etc/openldap. If your 
LDAP server uses a port other than 389, you need to edit that file to specify the correct port number in the line 
beginning with the “port” keyword. The file nsswitch.conf will be updated to feature “ldap” as a source for the 
password and group maps, and the pam_unix2 PAM module configuration will be modified to use LDAP as an 
authentication (with the parameters specified in /etc/openldap/ldap.conf).
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Kerberos Authentication Using Active Directory

 

The Java Desktop System can also be configured to work with an existing Active Directory using Kerberos-based 
authentication. Because Kerberos authentication is supported on current Microsoft systems, including Windows 
2000 and Windows XP, and is also supported on the Java Desktop System and other UNIX systems (such as the 
Solaris OS), it is a practical choice.

1. Enable Kerberos on Active Directory

– No modifications are required (the standard implementation of Microsoft Active Directory supports 
Kerberos authentication).

2. Enable Kerberos on the Java Desktop System

– Using the Java Desktop System Configurator (included with the software), install the pluggable authentication 
module (PAM) for Kerberos authentication.

– To activate it, modify the PAM configuration of the GNOME Display Manager (filename: /etc/pam.d/gdm) 
to take advantage of the new Kerberos module. When completed, the PAM will initially execute standard 
UNIX authentication and then pass a supplied password to the Kerberos authentication module. If Kerberos 
authentication fails with the supplied password, a prompt will request a second password.

3. Configure the PAM Kerberos module for the Active Directory server

– Collect the following information and edit the PAM Kerberos module (file: /etc/krb5.conf) as needed:
– The name of the Active Directory host that acts as the Key Distribution Center (KDC) for Kerberos 

(ADHost.my.domain).
– The domain names of all Kerberos hosts, including both Java Desktop System clients and Active Directory 

servers (my.domain).
– The Kerberos realm name (my.realm, may be identical to the domain name).

4. Synchronize host clocks

– Synchronize the clocks on the Java Desktop Server host and the Active Directory host.

For more details, please see the 

 

Sun Java Desktop System Configuration Manager, Release 1 – Installation 
Guide 

 

located at

 

 

 

docs.sun.com.

 

Accessing Microsoft Mail, Messaging, and Collaboration Services

 

The Java Desktop System uses mail, messaging, and collaboration network services for e-mail, calendar, and address 
book integration in the Mozilla browser and the Evolution mail and calendar client (similar to Outlook). These 
Microsoft mail and messaging services use the proprietary MAPI interface, but can be configured to accept open-
standard interfaces. A Java Desktop System connector called the Java Enterprise System Calendar Server Gateway is 
available to access collaboration tools. Using any one of the following open interfaces, the Java Desktop System 
can interoperate with existing Exchange Server services:
• POP
• IMAP4
• Gaim XMPP Gateway (for instant messaging using MSN Messenger)
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IMAP or POP

 

Both the Java Desktop System and Microsoft services can be configured to work transparently using either the 
IMAP4 or POP protocols. To enable IMAP4 or POP on Exchange Server, follow these steps:

1. Enable either IMAP4 or POP on Exchange Server

– Modify the default protocol mode in Exchange Server to accept either IMAP4 or POP.

2. Enable IMAP4 or POP on the Java Desktop System

– Select the Mail Server Type in Evolution. (Note: Do this the first time the application is launched.)
– Select Application-> E-mail & Calendar.
– A wizard will prompt to: Enter Account Information (Name, E-mail Address, Reply-To, Organization, 

and Optional Information).
– Enter Mail Server Type (Select IMAP4, POP, or a number of others from the scrolldown list).
– Enter Additional Information (Host Name, User Name, and then authentication method [usually Password]).

 

Gaim XMPP Gateway (Instant Messaging Interoperability With MSN Messenger)

 

Gaim (gaim.sourceforge.net) is a multiprotocol instant messaging client for both the Java Desktop System and 
Windows. It is compatible with Instant Relay Chat (IRC) and Jabber on the Java Desktop System side and with 
MSN Messenger on the Microsoft side. To launch Gaim on the Java Desktop System, follow these steps:

1. Launch Gaim XMPP Gateway on the Java Desktop System

– Select Launch->Application->Internet – Instant Messaging.
– Click on “Accounts” and a wizard will prompt you through the necessary steps.

 

Java Enterprise System Calendar Server Gateway

 

The Java Enterprise System Calendar Server Gateway, included with the Java Desktop System, allows the use of
Outlook calendaring in the Java Desktop System environment. The Gateway includes:
• Desktop Deployment and Configuration Program, for automatic deployment
• Outlook plug-in, for real-time access to mail, calendar, and directory services via Outlook

 

Accessing File Storage Services

 

The Java Desktop System uses file storage services to distribute file systems across a network, enabling users of
heterogeneous clients to remotely mount directories (subject to security settings) from a file server, just as though 
they were components of the local file system. There are two protocols available for the Java Desktop System to 
access file storage services:
• Network File System (NFS)
• Common Internet File System (CIFS) via SAMBA

 

Choosing the Best Protocol for Your Environment

 

NFS is the standard operating environment component of Linux servers. CIFS is the latest of Microsoft’s file net-
working protocols, and is used primarily by Windows clients to mount server file systems as additional drives on 
their own system. CIFS can be delivered by the SAMBA open source project (the name SAMBA is derived from the 
underlying protocol, known as Server Message Block, used by CIFS).
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When choosing between the NFS or SAMBA protocols, consider the following:
• Windows clients will find it easier to access SAMBA servers, although Windows-based NFS clients are available.
• Active Directory users can integrate the latest version of SAMBA 3.x into an Active Directory forest as a domain 

server. NFS servers are not recognized by Active Directory.

 

NFS

 

1. Enable NFS in the Microsoft environment

– No modifications are required.

2. Enable NFS on the Java Desktop System

– Click the “Network Places” icon on the Java Desktop System desktop.
– Select either UNIX Network or Windows Network.

 

SAMBA

 

1. Enable SAMBA in the Microsoft environment

– No modifications are required.

2. Enable SAMBA on the Java Desktop System

– Click the “Network Places” icon on the Java Desktop System desktop.
– Click “Add Network Place” and select “Windows Network (SMB)” from the list of choices.
– From the pop-up window, specify the Share Name (you can browse SMB shares on the network from this 

interface) and the Shortcut Name (to identify the Share Name on the Java Desktop System). Then select a 
login user name (a password will be requested upon first connection).

 

Accessing Printing Services

 

The Java Desktop System enables users to access and use printers connected to an existing Microsoft environment 
using CIFS via SAMBA.

1. Enable SAMBA in the Microsoft environment

– No modifications are required.

2. Add a SAMBA (SMB) printer in the Java Desktop System environment

– Select Launch->Preferences->Printers (this is the equivalent of traversing the Windows “Start Menu”).
– Double-click “New Printer” and enter the password for the root. Adding a printer must be performed by a 

user with “root” privileges. The user name “root” is the base user in a UNIX system.
– Select “Windows Printer (SMB)” from among the printer types.
– Specify the printer configuration, including Host Name, Printer Name, SMB Group Name, User Name, and 

Password. Once completed, a printer icon will be added to the Printers window.
– Right click on the new printer icon and select “Properties.”
– Select “Print Test Page” to verify the printer definition.
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Chapter 5

 

Enterprise Application Deployment Scenarios

 

There are a number of approaches for deploying (existing) enterprise applications to the Java Desktop System, including:
• Migrating to existing Java Desktop System application equivalents
• Rewriting applications using Java development tools
• Porting
• Bridge software to access Windows applications
• Remote presentation of Windows and legacy applications
• Running Windows on the Java Desktop System
• Dual boot from separate partitions

 

Migrate to Java Desktop System Applications

 

One enterprise application deployment strategy is to migrate legacy applications to existing Java Desktop 
System applications. Many applications you may be using on Windows are already available on the Java Desktop 
System, for instance Adobe Acrobat Reader and Macromedia Flash Player. Many more applications provide similar 
or equivalent functionality on the Java Desktop System as they do on Windows.

Also note that applications written using Java technology will run out-of-the-box on any platform — your old 
one as well as on the Java Desktop System. The number of enterprise applications using the Java 2 Platform, 
Standard Edition (J2SE platform) grows daily. A partial list is available on the enterprise section of java.com.

 

Rewrite Using Java Technology

 

Rewriting applications using Java technology is a good long-term strategy. The enterprise section of java.com 
provides a directory of existing Java applications. Java applications are portable across multiple operating systems 
and versions as well as multiple hardware platforms, and the Java environment offers excellent infrastructure for 
security and reliability.
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Java developer tools included with the Java Desktop System Release 2 include Java Studio Standard, NetBeans™ 
IDE, and Java 2 Platform, Standard Edition (J2SE platform). The Sun Java tools Web page (developers.sun.com/
prodtech/javatools) provides technology FAQs, technical articles and tips, partner program information, a knowledge 
base, community services, and learning tools.

 

Porting

 

For large enterprise applications, porting remains an option. Several tools are available from Sun partners to help 
in porting. For instance, Mainsoft (mainsoft.com) enables developers to port .NET Web applications and Web services 
to the Java 2 Platform, Enterprise Edition (J2EE™ platform), sharply reducing time to market and development costs.

 

Bridge Software

 

Native Windows applications can be run in the Linux environment using “bridge” software to replicate the Windows 
application programming interface (API). Once installed, applications integrate with the Java Desktop System 
environment and run as if on Windows. CodeWeavers CrossOver Office (codeweavers.com) and TransGaming 
(transgaming.com) are two of the best known examples of bridge software, both based on the Wine open source 
project (winehq.org).

CodeWeavers supports a growing set of Windows programs, listed on codeweavers.com/site/products/cxoffice/
supported_apps. For supported applications, this solution is fast, resource light, and inexpensive, although many see 
it as a transition step rather than a long-term solution. The CodeWeavers CrossOver plug-in supports many Windows 
plug-ins directly from the Java Desktop System Mozilla browser.

 

Remote Presentation of Applications

 

In this scenario, existing enterprise applications continue to run in the native Windows environment while the 
application interface displays on a Java Desktop System client. For example, Windows Terminal Services (WTS) can 
be used to deliver a presentation layer service to rdesktop, ThinSoft, or Tarantella Enterprise 3, all of which emulate 
the Microsoft Remote Display Protocol (RDP). This setup may be a good choice when several Windows applications 
must coexist with Java Desktop System applications.

Alternatively, a Citrix MetaFrame Application Server on the Windows server can remotely display native Windows 
application sessions to devices that serve as thin clients (a Java Desktop System client, Windows-based terminal, 
or traditional desktop PC with Citrix client software installed).

Note that in either of the these scenarios, Microsoft requires payment for additional Client Access Licenses 
(CALs) for each concurrent client device or system.

Legacy mainframe applications can be displayed using terminal emulation software, such as Ericom PowerTerm 
(ericom.com/sunray).
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Table 11 compares the attributes of ThinSoft, Tarantella, Citrix, and rdesktop application presentation solutions.

 

Table 11. Windows terminal services software comparison

 

Run Windows on the Java Desktop System

 

NeTraverse Win4Lin (netraverse.com/products/win4lin) and VMware Workstation (vmware.com/products/desktop/
ws_features.html) allow Windows to run on top of the Java Desktop System, thus providing native access to Windows 
applications while still benefiting from the underlying stability of the Java Desktop System. One advantage of this 
approach is the relative simplicity of the initial setup, while the disadvantage is the cost (Windows licenses are 
necessary), long-term management complexity, and continued reliance on Microsoft.

 

Dual Boot from Separate Partitions

 

A dual-boot, multipartition deployment is another option for enterprises using both Java Desktop System and 
native Windows applications during the transition period. In this scenario, one bootable partition is created for 
Windows and its associated applications, and another for the Java Desktop System and its associated applications. 
Such a deployment may be particularly appropriate for help desk and support personnel, and is often used within 
Sun Services.

 

Attribute ThinSoft Tarantella Citrix rdesktop

 

RDP version supported 5.2 5.x ICA 5.x

Max colors

 

a

 

a. Maximum colors, sound, and disk access require RDP 5.2 (W2k3 and Windows XP).

 

16 million 16 million 16 million 16 million

Sound support

 

a

 

Yes No Yes Yes 

Local printer support Yes No Yes Beta

Local disk access Yes No Yes Beta

Local communication port access Yes No Yes Beta

Requires middleware

 

b

 

b. Middleware is defined as the addition of an extra software product, either on the host system (for example, Citrix), or installed on an extra server layer (for 
example, Tarantella).

 

No Yes Yes No 

Client GUI Yes Yes Yes Yes

Support for UNIX servers No Yes No No

Support for z/OS and OS/400 No Yes No No

Support for browser access No Yes Yes No

Command line options Yes Yes Yes Yes

Technical support Yes Yes Yes No

Requires Microsoft licenses Yes Yes Yes Yes

Cost per client

 

c

 

c. MetaFrame Xpe.

 

$149 $250 $350 Free
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